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Index to Checklist topics

   Nomenclature used in 

The Compleat Botanica 

Notes on the methodology followed to assemble the Compleat Botanica's 

checklist of plant names. 

   Checklist 

hierarchy 

The Checklist hierarchy is a listing of all taxonomic names available in The 

Compleat Botanica. The hierarchy allows you to expand or collapse portions 

of the tree to see taxonomic names subordinate to the selected name. 

   Reclassifying a plant 

taxon 

Although the need to reclassify botanical names is uncommon for the 

layman, it is necessary for professional taxonomist. 

   Checklist 

View 

The Checklist View displays the details of an individual botanical name 

entry. 

   Corrected family 

assignments 

Genera that were assigned to incorrect Families in Build 85 

 



Compleat Botanica - Nomenclature used in The Compleat Botanica
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The Compleat Botanica follows the nomenclatural assignments of Reveal for the classification of families into the higher 

ranks of family, order, class and division. Some genera are also assigned to sub-families, tribes, and sub-tribes, however 

the full research into this will take many more years to complete and thus the current hierarchy is only partially 

representative of these ranks.

The assignment of genera to families has followed the publication of the Royal Botanical Garden at Kew except where 

Reveal has superceded this.

The assignment of species, sub-species, and varieties follows the publication by the USDA-NRCS.

Numerous corrections to the taxonomy have been made since the Build 85 release of the Compleat Botanica. You can 

obtain these corrections and apply them to existing databases by following the instructions in Technical Bulletin #10.

Please see the full list of citations at Checklist of botanical names used in The Compleat Botanica. 
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Compleat Botanica - Checklist hierarchy
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The Checklist hierarchy is a listing of all taxonomic names available in The Compleat Botanica.  The hierarchy allows 

you to expand or collapse portions of the tree to see taxonomic names subordinate to the selected name.  Simply double 

click on any name to see all related entries one rank below.  To expand the entire tree below the selected name hold 

down the <CTRL> key while double-clicking.  Use caution when doing this from the higher ranks since the retrieval and 

display of many thousands of lower entries may take a very long time. 



New names may be added and obsolete or incorrect names may be deleted using the buttons at the bottom of the 

hierarchy.  This is an advanced option for people working in the field of nomenclature and taxonomy.

At the time of this writing some entries are of uncertain parentage and have been placed under a parent named 

"<incertae>".  If you are an expert in a particular field of botany you can correctly assign these entries to their proper 

parentage using the Reclassify feature.

Note that the additions, deletions, and reclassifications performed on the checklist is done on a per-database case.  To 

copy the modified checklist to another database, use the export and import features.

Table of botanical ranks

The rank of each entry is identified by the green icon to the left of the name.  Here is a table of the codes used within the 

hierarchy:

Icon Rank (English) Rank (Latin) Database value Notes

R kingdom regnum 0

Rs sub-kingdom subregnum 1

D division divisio 2
also known as phylum in the plant 

kingdom

Ds sub-division subdivisio 3
also known as sub-phylum in the plant 

kingdom

C class classis 4

Cs sub-class subclassis 5



Os super-order superordo 6

O order ordo 7

Os sub-order subordo 8

F family familia 9

Fs sub-family subfamilia 10

T tribe tribus 11 secondary rank

Ts sub-tribe subtribus 12 secondary rank

G genus genus 13

Gs sub-genus subgenus 14

Se section sectio 15 secondary rank

Ses sub-section subsectio 16 secondary rank

Sr series series 17 secondary rank

Srs sub-series subseries 18 secondary rank

S species species 19

Ss sub-species subspecies 20

V variety varietas 21 secondary rank

Vs sub-variety subvarietas 22 secondary rank

F form forma 23 secondary rank

Fs subform subforma 24 secondary rank

C cultivar 25
non-botanical name defined by the 

association for horticultural plant names.



Compleat Botanica - Reclassifying a plant taxon
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Although the need to reclassify botanical names is uncommon for the layman, it is necessary for professional taxonomist.  The 

actual process of reclassifying a botanical name within the software is simple enough:  select the name to be reclassified and 

press the button at the bottom of the checklist hierarchy.

On the left-hand half of the reclassify window, select the new parent for the name to be reclassified.  On the right-hand half of 

the window, select the rank for the name.

 



Compleat Botanica - Checklist View
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The Checklist view displays the details of an individual botanical name entry.  Here is 

where you can find information about a plant name.  These names may be at any level of 

the taxonomic hierarchy. 



 

Item Description

Rank
The rank within the hierarchy, for example, ordo, familia, genus, species, and so forth.  

This level is shown just to the left of the taxon name.

Taxon name
The name of the entity.  All names at the rank of genus and above are unique.  Names 

names below genus are non-unique.

Common name
One or more common names for this taxon name.  You may want to add your own common 

names to this field.

Author

An abbreviation of the last name of the author of this plant name.  The author is the person 

who first validly published a description of this plant name.  This attribution is a required 

part of the botanical name for botanists and other scientists.  It is not commonly applied to 

plant names vernacularly.

Publication A citation of the first publication of this name.

Source The Compleat Botanica's source of the author and publication data.

Original name

The name originally used for this item.  Validly published names are sometimes changed to 

conform with the standards of the International Association of Plant Taxonomists code.  

These rules require plants at certain levels of the hierarchy to have certain name endings.  

For example, family names must end in -aceae.

Synonym Other validly published names which synonymously refer to this item. 

Specimen available

You may check this box to indicate that you have a specimen of this type in your collection.  

All higher-level names in the hierarchy are automatically checked for you.  In this way you 

can see the diversity of your plant collection. 

Notes

You may freely add notes about the plant name here. 

See What's possible with the notes area, Adding cross references to specimen in the notes 

area, and Limitations on the note fields.
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Compleat Botanica - Corrected family assignments
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Build 85 of the Compleat Botanica contained 88 genera that were incorrectly assigned to families. This table lists the 

entries that have been corrected. See Technical Bulletin #10 for more about this.

Genus Incorrect family Correct family

Anacampseros Crassulaceae Portulacaceae

Aplectrum Melastomataceae Orchidaceae

Bellevalia Euphorbiaceae Hyacinthaceae

Benthamia Cornaceae Orchidaceae

Blumenbachia Gramineae Loasaceae

Bowringia Blechnaceae Leguminosae

Brachylepis Asclepiadaceae Chenopodiaceae

Brachynema Escalloniaceae Olacaceae

Bridgesia Cactaceae Sapindaceae

Brugmansia Rafflesiaceae Solanaceae

Bruguiera Combretaceae Rhizophoraceae

Brya Chrysobalanaceae Leguminosae

Centranthera Orchidaceae Scrophulariaceae

Chamaeanthus Commelinaceae Orchidaceae

Clintonia Campanulaceae Convallariaceae
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Cristaria Combretaceae Malvaceae

Cuviera Gramineae Rubiaceae

Dielsia Labiatae Restionaceae

Dipogon Gramineae Leguminosae

Donax Gramineae Marantaceae

Dryandra Euphorbiaceae Proteaceae

Dunalia Rubiaceae Solanaceae

Edgeworthia Sapotaceae Thymelaeaceae

Gonocarpus Combretaceae Haloragaceae

Grafia Orchidaceae Umbelliferae

Griffonia Chrysobalanaceae Leguminosae

Gymnotheca Marattiaceae Saururaceae

Helicia Loranthaceae Proteaceae

Henlea Malpighiaceae Rubiaceae

Hoffmannia Psilotaceae Rubiaceae

Horsfieldia Araliaceae Myristicaceae

Huanaca Solanaceae Umbelliferae

Kleinia Combretaceae Compositae

Krascheninnikovia Caryophyllaceae Chenopodiaceae

Lagotis Rubiaceae Scrophulariaceae

Lepidostemon Convolvulaceae Cruciferae



Leptomeria Euphorbiaceae Santalaceae

Leptopyrum Gramineae Ranunculaceae

Lichtensteinia Loranthaceae Umbelliferae

Lophiocarpus Alismataceae Phytolaccaceae

Macrostylis Orchidaceae Rutaceae

Malacocarpus Cactaceae Zygophyllaceae

Meeboldia Capparaceae Umbelliferae

Micranthus Acanthaceae Iridaceae

Microphysa Melastomataceae Rubiaceae

Miquelia Gesneriaceae Icacinaceae

Molinaea Palmae Sapindaceae

Molineria Gramineae Hypoxidaceae

Mollia Myrtaceae Tiliaceae

Niemeyera Orchidaceae Sapotaceae

Nymania Euphorbiaceae Meliaceae

Oreocallis Ericaceae Proteaceae

Pachyloma Hymenophyllaceae Melastomataceae

Petagnia Solanaceae Umbelliferae

Phacellanthus Cyperaceae Scrophulariaceae

Phacellaria Gramineae Santalaceae

Pierreodendron Sapotaceae Simaroubaceae



Platonia Gramineae Guttiferae

Platylepis Cyperaceae Orchidaceae

Rafinesquia Bignoniaceae Compositae

Rhopalostylis Euphorbiaceae Palmae

Riedelia Gramineae Zingiberaceae

Roemeria Gramineae Papaveraceae

Rostellaria Acanthaceae Sapotaceae

Rothia Gramineae Leguminosae

Roylea Gramineae Labiatae

Schizocalyx Myrtaceae Rubiaceae

Schizostigma Cucurbitaceae Rubiaceae

Schlumbergera Bromeliaceae Cactaceae

Schradera Euphorbiaceae Rubiaceae

Schultesia Campanulaceae Gentianaceae

Shortia Cruciferae Diapensiaceae

Shuteria Convolvulaceae Leguminosae

Silvaea Euphorbiaceae Portulacaceae

Spermolepis Myrtaceae Umbelliferae

Spiranthera Convolvulaceae Rutaceae

Spirostachys Chenopodiaceae Euphorbiaceae

Stilpnophyllum Moraceae Rubiaceae



Stipularia Ranunculaceae Rubiaceae

Talbotia Acanthaceae Velloziaceae

Tetradium Crassulaceae Rutaceae

Tetrastigma Rubiaceae Vitaceae

Todaroa Orchidaceae Umbelliferae

Tristania Gramineae Myrtaceae

Uncaria Pedaliaceae Rubiaceae

Wangenheimia Araliaceae Gramineae

Webera Melastomataceae Rubiaceae

Zenkeria Bignoniaceae Gramineae

 



Compleat Botanica - Spell-checker and formatting rules
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Index to spell-checker and formatting topics

   Understanding how the 

botanical name spell-

checker works 

The Compleat Botanica contains a checklist of genus names, species 

epithets, sub-species and varieties. The overwhelming majority of these 

names are for vascular plants: angiosperms, gymnosperms, spore bearing 

ferns and their allies. 

   All about family 

names 

Families exhibit common characteristics that in a subjective sense group 

them together. 

   Family name 

endings 

The official taxonomic naming convention for families is that they end with -

aceae. Only a few exceptions have survived. 

   Inter-generic 

hybrids 

Inter-generic hybrids are formally identified with a cross symbol prefixing 

their name. 

   What are the rules for 

proper formatting of 

botanical names? 

The genus name must begin with a capital letter and be followed by all lower 

case letters. Species epithets are to be all lower-case letters. 

   The Uncertain taxonomy 

checkbox 

Sometimes the full genus, species, and variety is not known for a specimen. 

 



Compleat Botanica - Understanding how the botanical name spell-checker works
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The Compleat Botanica contains a checklist of 26,334 genus names, 54,662 species epithets, 23,227 sub-species and 

varieties. The overwhelming majority of these names are for vascular plants: angiosperms, gymnosperms, spore bearing 

ferns and their allies.

As you create a new specimen record, you’ll want to begin by typing the genus. If there’s a question about it’s correct 

spelling, just type the first few letters of the name then click on the combo-box button to find the genus in the drop-

down list.

The species name can be typed in or chosen from the drop-down list. Only species of the current genus are listed. In this 

example, the species names for the Acer genus are listed.



The same steps work for the variety. You can either type in the variety name or select from the drop-down list. In this 

example, the varieties and sub-species of Acer negundo are shown.



Note that the variety field is also used to enter the sub-species name if it exists. (The sub-
species name is infrequently used and it’s rare to have both a sub-species and a variety for 
an individual specimen.)

 



Compleat Botanica - All about family names
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In the official taxonomic ordering of botanical names a family is a collection of tribes and a tribe is a collection of 

genera. For most of us, the tribe is not important and we like to conveniently assign a genus directly to a family. 

Families exhibit common characteristics that in a subjective sense group them together. For example, Juglandaceae (the 

walnut family) consists of 10 genera which bear nuts in a fleshy husk. Other characteristics such as their leaf shape and 

arrangement distinguish them in the minds of botanists from similar plants. Some families are quite large, such as 

Asteraceae (the sunflower family), which contains 1677 genera.

Subjective by their very nature, family names have recently become even more confusing with advancements in 

genetics. Genera are sometimes reassigned to different families and well-known families are renamed or disappear 

altogether. Making sense of this is the task of hard working researchers. The Compleat Botanica uses the family names 

of Walters & Keil who follow Cronquist in their general classification. This scheme is modified to show the validly 

published names above the rank of genus as identified by Reveal. The result is a taxonomic hierarchy of 1652 family 

names which give useful clues to the origin of the plant and its generic name.

 



Compleat Botanica - Family name endings
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The official taxonomic naming convention for families is that they end with -aceae. Only a few exceptions have survived: 

Palmae, Gramineae, Cruciferae, Leguminosae, Guttiferae, Umbelliferae, Labiatae, and Compositae.  (See Section 2, 

Article 18.5 of the International Code of Botanical Nomenclature for details).

Before the age of computers, the ending was spelled with the special letter æ so that Fabaceae was spelled Fabaceæ. 

Recently, with the introduction of UNICODE, a return to this older style of spelling has become more commonplace. 

The Complete Botanica allows both methods to be used. To switch from one style ending to the other use the Customize 

settings window.

 

By convention, family names are usually shown in all upper case letters. Here is what the drop-down combo-box for all 

family names beginning with “AC” looks like:



Note that regardless of how the names are displayed, they are always stored in the database 
as “AE”.

 



Compleat Botanica - Inter-generic hybrids
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Inter-generic hybrids are formally identified with a cross symbol prefixing their name. This symbol looks like a small 

letter “x”. Before the advent of UNICODE, this symbol was not present in most computer fonts, thus the common 

practice was to substitute the cross symbol for with the lower case letter “x”. This convention allows for easy entry of 

these names and has been adopted by The Compleat Botanica.

Note that the first letter of a species names is always capitalized (this is automatically done 
for you by the software). In the case of inter-generic hybrids the “x” is not considered to be 
the first letter.

 



Compleat Botanica - What are the rules for proper formatting of botanical names?
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A botanical name consists of a genus name and a species epithet.  The genus name must begin with a capital letter 

and be followed by all lower case letters.  Species epithets are to be all lower-case letters.  Both the genus and species 

should be italicized.

When a botanical name contains a subspecies component the abbreviation "ssp." or "subsp." is inserted before the 

subspecies in a non-italicized font.

When a botanical name contains a variety component the abbreviation "var." is inserted before the variety in a non-

italicized font.

When a botanical name contains a cultivar component the name is surrounded by single quotes and is displayed in a 

non-italicized font.

The International Association for Plant Taxonomy has prescribed the following rules for formatting plant names:

Summary International Code of Botanical Nomenclature (St. Louis Code)

Initial capital letter for  genus
20.1. The name of a genus is a noun in the nominative singular, or a word treated 

as such, and is written with an initial capital letter. . . .

Species

23.1. The name of a species is a binary combination consisting of the name of the 

genus followed by a single specific epithet . . . . If an epithet consists of two or 

more words, these are to be united or hyphenated.

Species lower-case

60F.1. All specific and infraspecific epithets should be written with an initial 

lower-case letter, although authors desiring to use initial capital letters may do 

so when the epithets are directly derived from the names of persons (whether 

actual or mythical), or are vernacular (or non-Latin) names, or are former 

generic names

Cultivar epithets

28 Note 5. The International code of nomenclature for cultivated plants 

provides for the establishment of cultivar epithets differing markedly from 

epithets in Latin form.



Latin alphabet

60.4. The letters w and y, foreign to classical Latin, and k, rare in that language, 

are permissible in Latin plant names. Other letters and ligatures foreign to 

classical Latin that may appear in Latin plant names, such as the German ß 

(double s), are to be transcribed. 

To be validly published, a botanical name must include its author.  The Compleat Botanica's checklist of botanical 

names includes the author in most cases.  Nevertheless the author's name is not shown on-screen or on reports because 

it is not of interest to the non-scientific community.

 



Compleat Botanica - The Uncertain taxonomy checkbox
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Sometimes the full genus, species, and variety is not known for a specimen. In these cases, you can place a checkmark in 

the “Uncertain taxonomy” box to indicate this. The automatic botanical spell-checker does this for you if you mistype a 

name. If you are certain you’ve spelled the name correctly and it just isn’t in the checklist, you can remove the 

checkmark.

This name is not in the checklist.

In some cases you may want to place “<incertae genus>”, “<incertae species>”, “<incertae varietas>”, “<incertae 

familia>” in the fields that you are uncertain about. This serves as a reminder to do more research.

 



Compleat Botanica - Vernacular names
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Index to vernacular name topics

   Vernacular name 

list 

The vernacular name list is used to display common name equivalents to 

proper botanical names. 

   Vernacular name 

view 

The Vernacular name view displays additional information about a common 

name such as its country of origin and whether or not it is a non-English 

language name. 

   Common name 

popup 

Common names are associated with entries in the specimen list and can be 

seen when the Identification View is active. 

 



Compleat Botanica - Vernacular name list
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The Vernacular name list is used to display common name equivalents to proper 

botanical names.  Using this window you can search for entries using just portions of a 

name and thus easily find obscure or hard to spell names.  This window can be used to 

search for either botanical names or common names. 



 Item Notes

1

Use this area to enter part or 

all of a name to look up.  Press 

the refresh button to display 

the list of matching entries.

2

Toggle these two buttons like 

this to search for common 

names matching your request.

3

Toggle these two buttons like 

this to search for botanical 

names matching your request.

4

Toggle these two buttons like 

this to search for entries that 

begin with your typed text.

5

Toggle these two buttons like 

this to search for entries that 

contain your typed text 

anywhere in its name.  

 

 



Compleat Botanica - Vernacular name view
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The Vernacular name view displays additional information about a common name 

such as its country of origin and whether or not it is a non-English language name. 

 



 

 Item Notes

1 Common name
When a single common name applies to more than one botanical name, a 

separate vernacular name entry exists for each pair of names.

2 Botanical name The formal botanical name that this common name refers to.

3 Rank
The taxonomic rank of the botanical name.  This name is automatically 

supplied when you type a valid botanical name.

4 Locality The country or other locality where this name is in common use.

5 Meaning
When this is an historical name or a foreign-language name, the translated 

meaning can be supplied here.

6 Preferred name
When more than one common name is used to refer to the same species, this 

is checked to indicate which is the one most often used.

7 Historical name
Checked when this is an older name that is used in historical writings but is 

not used in everyday speech.

8 Foreign language Checked when this is not an English language name.

9 Data source
This is a reference to the source material where this common name can be 

found.

10 Press this button to create a new specimen record with this botanical name.

11 Go to the specimen record with this botanical name.



12 Go to the taxonomic details for the referenced botanical name.

 



Compleat Botanica - Common name popup
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Common names are associated with entries in the specimen list and can be seen when the Identification View is active.  

This same list of common names is associated with taxonomic entries and can be seen in the Checklist View.  In both 

cases you can quickly add, remove, and change these common names using the little popup window accessible by 

pressing the button just to the right of the list. 

 

The three buttons along the top left of the popup window are for adding, removing, and saving changes made to a 

common name.  The single button in the top right hand corner simply closes the popup window. 

Changes made to this list will be visible in the Vernacular List where you can make additional changes to the name's 

detailed record. 

 



Compleat Botanica - Things you can do with your pictures
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Index to picture topics

   Recommendations for 

your picture files 

Your picture files are not stored in the database together with your specimen 

data; instead they are kept in their original location. 

   Setting the default picture 

directory 

Picture files can be specified using the full drive and directory as part of the 

filename. Optionally, you can leave the drive letter and directory off the 

name of the picture file if it is located in the default directory. 

   Overview of picture 

files 

Digital pictures captured with today's new cameras are easy to take and fun 

to have. Pictures of your specimen can be conveniently organized, displayed 

and printed using The Compleat Botanica. 

   Using the picture 

previewer 

The picture previewer is a separate window which can float on top of other 

windows or behave in the normal overlapping fashion. 

 



Compleat Botanica - Recommendations for your picture files
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Your picture files are not stored in the database together with your specimen data; instead they are kept in their original 

location. The database only keeps the location of each picture file. The advantage to this is that these large picture files 

are only taking up space on your disk once. Your can organize your picture files in any way that makes sense to you.

To see your specimen pictures from within The Compleat Botanica program, enter the directory and filename in the 

space provided on the Sketch View.

 



Compleat Botanica - Setting the default picture directory
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Picture files can be specified using the full drive and directory as part of the filename.  This is called an absolute file path.  Optionally, you can leave 

the drive letter and directory off the name of the picture file if it is located in the default directory.  This option is useful when you anticipate 

moving your pictures or when more than one database shares the pictures.

You can change the location of the default picture directory from the Customize settings window.

 



Compleat Botanica - Overview of picture files
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Digital pictures captured with today's new cameras are easy to take and fun to have.  Pictures of your specimen can be 

conveniently organized, displayed and printed using The Compleat Botanica. 

Each specimen record has a special field 

designated for picture files.  Use the file finder 

button to locate your picture file.  Pictures stored 

in JPEG or GIF format can be accommodated.  

For more about how pictures are stored see the 

document Setting the default picture directory. 

 

 

To see your pictures full-sized, use the picture preview button; 

this will display your pictures in a separate window.  You can 

scroll through your pictures by keeping this window open and 

changing the currently selected specimen record.  See the 

document Using the picture previewer for more about this.

 



Compleat Botanica - Using the picture previewer
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The picture previewer is a separate window which can float on top of other windows or behave in the normal 

overlapping fashion.  When kept in front, the preview window can be used to quickly look through all of your digital 

pictures.  To do this, be sure the "Front" button is toggled on, then simply change the currently selected specimen 

record using the Specimen List.  You can use the up and down arrow keys to scroll through your entire collection in this 

way.

The six buttons at the top of the window have the following use:

  

Button Usage

Fit
Show the entire picture within the boundaries of the window.  When you resize the window the picture 

will shrink or expand to fit entirely within the window

Full
Show the picture at full size.  This is the pixel-for-pixel representation of the picture shown without 

any compression or expansion in size.

Front
Keep the picture preview window on top of all other windows.  Use this option when scrolling through 

your specimen list.

Back
Place the picture preview window behind other windows when it isn't the active window.  This is the 

normal behavior for windows.

Print Print the full sized picture

Close Close the picture preview window



 



Compleat Botanica - Printing
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Index to printing topics

   Printing 

reports 

Index to report generation topics. 

   Printing 

labels 

Index to topics about printing labels. 

   Printing Pathfinder 

documents 

Index to printing Pathfinder documents. 

   Printing Checklist 

reports 

Index to printing Checklist reports. 

 



Compleat Botanica - Printing reports
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Index to printing reports topics

   Basic steps for printing 

specimen reports 

Good default values are set up for you when install the software so that you 

can begin printing without any fuss. 

   Tips for printing great 

looking reports 

Here are some tips for printing specimen reports that may not be obvious at 

first glance. 

   Choosing a report 

style 

When The Compleat Botanica is installed, a variety of report styles are 

preloaded. 

   WYSIWYG print 

preview 

The Print Preview window is a what you see is what you get (WYSIWYG) 

display. 

   Defining report style 

fonts 

Using the Fonts tab of the Report Style Definition you can change the 

characteristics of the text shown in the report. 

   Defining report style 

borders and shading 

Using the Borders tab of the Report Style Definition you can change the 

borders and shading of the report. 

   Defining report style 

options 

Using the Options tab of the Report Style Definition you can make changes 

to the overall appearance of the report. 

   Defining report style 

margins 

Using the Margins tab of the Report Style Definition you can override the 

automatic settings for the non-printable border area and the text margins. 



Compleat Botanica - Basic steps for printing specimen reports
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Good default values are set up for you when install the software so that you can begin printing without any fuss.  But when you want to 

customize the look of your reports, there are several things to know that may not be obvious at first glance.  Read the Tips for printing great 

looking reports to understand how the printing process works.

Step 1:  Select a filter

The filter you're using defines the 

columns of your report, the records to 

include, the sorting order, and the relative 

column widths of the report.  Use any 

existing filter, or create your own, with 

just the items you want to include on your 

report.

Step 2:  Print command

Begin the print process by choosing the Print Specimen command 

from the File menu.

Step 3:  Select a report style

Choose one of the predefined report styles, or create your own -- follow the instructions beginning with Defining report style fonts.



Choose 

whether to 

print all pages 

or a From 

and To range 

of pages. 

If you have 

more than 

one printer, 

select which 

one to use.  

Use the Print 

setup button 

to change 

special printer 

characteristics.

Use the 

Preview 

button to 

switch 

between 

Landscape 

and Portrait 

orientations.  

See 

WYSIWYG 

print preview 

for more 

about this.

Step 4:  Select portrait or landscape

On the Print preview window select the Orientation for your report.  Select one of the standard paper sizes, or use the Width and 

Height items to print to custom sized paper.



Use the 

green 

arrows to  

scroll left 

and right, 

up and 

down to see 

how the 

report will 

look on 

paper. 

The 

Scaling 

options 

allow you 

to zoom in 

on the 

report 

preview.  

Scaling 

does not 

affect how 

the report 

is printed. 

Step 5:  Press the Print button

Use the Print button from step 3 to print selected pages or the Print button from step 4 to print all pages.

 



Compleat Botanica - Tips for printing great looking reports

 Using the software    Printing    Reports   

Here are some tips for printing specimen reports that may not be obvious at first glance:

1
The current filter specifies which records are included in the Specimen List.  This same set of records will 

be included on your printed reports.  To include all of your specimen records, choose a filter that doesn't 

exclude anything.

2
The current filter defines which items are included the Specimen List.  This same set of items, in the same 

column-by-column ordering is included on your printed report.  To create a report that doesn't span the 

width of two or more pages, define a simpler filter which includes fewer columns.

3 The sorted order of records in your printed report is the same as the sorted order in your Specimen List.  

To read more about sorting see the document Sorting the list of specimen.

4

The width of columns in your printed report is proportional to the width of columns in the Specimen List.  

To adjust the column widths in your report to better fit your selected fonts and paper layout, return to the 

Specimen List and follow the instructions for Adjusting the specimen list column width.  Note that column 

widths are proportional, not exact.  Changing the font size of the of the Specimen List or the font size of 

your report will automatically adjust the column widths of the report.

5 Portrait and Landscape are controlled by the Orientation item on the Print Preview, not by the settings of 

your printer.
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6 The list of fonts shown in the Report Style Definition are the fonts available for the selected printer.  If the 

list of fonts seems too small, make sure you haven't selected a "Generic / Text Only" printer.

7 Each filtered set of records can be printed with any of the report styles.  By default, the report will be 

printed with the report style previously used by the selected filter.

 



Compleat Botanica - Choosing a report style

 Using the software    Printing    Reports   

When The Compleat Botanica is installed, a variety of report styles are preloaded.  These report styles are useful templates 

demonstrating color schemes, font styles and sizes, and the use of lines.  The basic color schemes are represented with styles 

named for the months of the year.   Additional features are demonstrated by modifying the twelve base color schemes.

Once you see how the predefined report styles have been constructed, you'll want to experiment with creating your own styles.

Report 

style
Sample

January

January 

side 

banner



February

March

April

May



June

July

August

August 

alternating



August 

with lines

August 

with 

stripes

September

September 

jumbo



September 

large

September 

small

September 

tiny



October

November

November 

fancy

November 

roman



November 

typewriter

December

 



Compleat Botanica - WYSIWYG print preview

 Using the software    Printing    Reports   

The Print Preview window is a "what you see is what you get" (WYSIWYG) display.  Using the print preview helps you to 

decide whether you need to adjust column widths, font sizes, or other features, all without wasting ink cartridges or 

paper.

There are several features which make the print preview useful:

1

  

The left and right, up and down scrolling buttons allow you 

to see all pages of the report.  The page numbers in the 

middle show the page down and page across numbers.  

This example is page one down and page five across.

Tip:  To continuously scroll, press and hold the button 

down until you reach the desired page. 

 

The page scale feature allows you to see more or less of the 

report on your screen.  Remember also that the entire print 

preview window can be sized larger or smaller just like any 



2
other sizable window. 

The whole page option scales the preview so that you can 

see the complete page within the window.  The page 

width option scales the preview so that you can see the 

entire width of the report within the window.  The page 

height option scales the preview so that you can see the 

entire height of the report within the window.

3 The paper size feature lets you match the size of paper in 

your printer to the size of the preview.



4

 

When using paper with a custom size, use the width and 

height items to match your paper's dimensions.

If you want to specify your dimensions in US Customary 

units (inches) or metric units (millimeters), you can use the 

Customize Setting window to change how units are 

specified. See the document Choosing measurement units 

for reports and labels.

 

5

  

 

Your report's orientation is set using this print preview 

feature; it is not set using the portrait/landscape option 

under printer settings.
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Compleat Botanica - Defining report style fonts

 Using the software    Printing    Reports   

Using the Fonts tab of the Report Style Definition you can change the 

characteristics of the text shown in the report.  

Seven different sections of the report's page layout can be customized in this 

manner:  the four edges of the page (title, left margin, right margin, and page 

footers), the column headers, and the two alternating bands of data. 

The two alternating bands of formatting for the specimen data is helpful for 

readers of your report to follow a row of text across the page.  If you don't need 

this feature, you can simply apply the same characteristics to both bands. 

Here's an explanation of each item in the Fonts tab of the Report Style Definition:

*

To change the font characteristics for one section, choose that 

section's name using the list shown here.  To apply changes to two or 

more sections simultaneously, use the <Ctrl> key on your keyboard to 

select multiple sections.  To apply changes to all seven sections, 

choose the <All sections> item.



*

  

If you do not want one of the four edges or the column headers, you 

can disable that section of the report.

 

*

The list of fonts is grouped into four font types: sans serif fonts, serif 

fonts, script fonts, and special fonts.  The blue symbols in the list 

indicate the font type. 

The font names shown in this list is based on which printer you've 

selected.  If you don't see very many fonts, make sure you haven't 

selected "Generic / Text only" as your destination printer.

* Font sizes range from 6 points to 72 points.



* 
When printing to color printers, use any of the standard text colors. 

When printing to black and white printers, choose from the gray 

palette.

*

  

Note that not all fonts have bold and italic.  Choose a font style 

available for your selected font.

 

*

  

Text is normally center aligned for the four edge sections and left 

aligned for the specimen data sections.  But a custom appearance is 

possible by choosing a different alignment.

Place any 

text in the 

four edge 

sections, or 

use one of 

the 

replacement 

tags.

*



Replacement 

tags allow 

you to 

create a 

report style 

definition 

that's 

adaptive.

*

 



Compleat Botanica - Defining report style borders and shading

 Using the software    Printing    Reports   

Using the Borders tab of the Report Style Definition you can change the borders and 

shading of the report.

Each of the seven different sections of the report's page layout can have different 

background colors and border elements. 

Here's an explanation of the items on the Borders tab:

*

To change the color and border characteristics for one section, choose that 

section's name using the list shown here.  To apply changes to two or more 

sections simultaneously, use the <Ctrl> key on your keyboard to select 

multiple sections.  To apply changes to all seven sections, choose the <All 

sections> item.

*

  

If you do not want one of the four edges or the column headers, you can 

disable that section of the report.

 



*

The background for each section can be a different color.  Use the lightest 

hues to make subtle and pleasing backgrounds without using a lot of printer 

ink. 

Only shades of gray are available when you select the black and white option.

*

Choose which edge or edges of the currently selected section you want to 

modify, then use the Width, Style, and Edge color items to make your 

customizations.  To select two or more edges, use the <Ctrl> key on your 

keyboard. 

You'll find the print preview sample window to be a convenient tool when 

defining edges because the edges of adjacent sections do not overlap, they 

abut each other.  Try various combinations of edges to find one that works 

right for you.  Look at how the predefined report styles have been set up for 

some ideas.

* The width of each edge can be adjusted from 0.25 font points to 4 font 

points.  0.25 is a hairline edge.  4.0 is a fat edge.

*

  

Choose simple edges or one of the double-line edges.

 



* 

Use darker colors for edges to make them more visible. 

Only shades of gray are available when the black and white option is in 

effect. 

See the sample at 

the bottom of the 

window to get a 

good idea of what 

the section will 

look like. 
*

 



Compleat Botanica - Defining report style options

 Using the software    Printing    Reports   

Using the Options tab of the Report Style 

Definition you can make changes to the overall 

appearance of the report.

Here are explanations for the items under the Options tab:

*

Choose either color or black and white.  When black and 

white is chosen, only shades of gray are available for fonts, 

backgrounds, and borders. 

Note that color icons, RHS color patches, and thumbnail 

pictures are still shown in color.  If your printer does not 

automatically convert these to gray scale, you may want to 

use the substitute with text graphics option.

*

Choose the use graphics option to show embedded date-

range graphics, height and spread symbols, icons, and 

thumbnail pictures. 

Choose the substitute with text option to print without 

these graphical elements. 

See Graphics in printed reports for samples.



*

The specimen data can be be printed using a single scheme 

or alternating schemes.  When the alternating row 

styles option is left unchecked, all specimen data is 

formatted using the "Specimen data (alternate 1)" section 

definitions. 

When the alternating row styles option is turned on, 

you can choose how many rows are to be banded together 

in each of the two alternate schemes.  Usually this value is 

1, but for special effects you can use 2 or a higher number. 

 



Compleat Botanica - Defining report style margins

 Using the software    Printing    Reports   

Using the Margins  tab of the Report Style 

Definition you can override the automatic settings 

for the non-printable border area and the text 

margins. 

*

The non-printable border area is the portion of 

each page that your printer uses for feeding, 

grasping, and ejecting the paper.  This is 

different for each printer.  Usually it is a very 

small portion of each edge.  If you choose to 

override this setting be aware that your report 

may look great on one printer but may be 

clipped on another printer. 

*

The text margin areas are used by the four edge 

sections defined in the Fonts and Borders 

tabs.  The minimum amount of space required 

for the selected font and border sizes are 

automatically calculated and adjusted as you 

make changes to each section of the report.  You 

may find it more pleasing to increase these 

minimum values to allow for extra space 

between elements. 

Tip:  For best results, keep the Override 

automatic settings turned off while changing 

the font sizes and edge styles, then override the 

settings when you know what the minimum 



values need to be.

 



Compleat Botanica - Graphics in printed reports

 Using the software    Printing    Reports   

Printed reports can contain graphical icons, colors, pictures, and 

special symbols.  When defining a new report style this feature can be 

kept or removed by specifying Use graphics or Substitute with 

text. 

Here are examples demonstrating the types of graphical output available.

Report 

style
Sample

Checkboxes



Icons

Date 

ranges and 

RHS colors



Height and 

spread



Climate 

zones



Symbols



More icons



Thumbnail 

pictures

 



Compleat Botanica - Printing labels

 Using the software    Printing    Labels   

Index to topics about labels

   Basic steps for printing 

labels 

Here's an overview of what it takes to prepare and print labels. 

   Tips for setting up 

accurate label layouts 

Here are some not-so-obvious tips for setting up and printing labels. 

   Choosing a label 

format 

When The Compleat Botanica is installed, several sizes of label layouts are 

predefined. 

   WYSIWYG label 

preview 

The Label Preview window is a what you see is what you get (WYSIWYG) 

display. 

   Defining label text and 

data values 

Use the Design Label window in the label format editor to specify text and 

data values to include on your labels. 

   Defining label fonts and 

colors 

Using the Design Label window you can change the fonts and colors used on 

each line of the label. 

   Choosing label 

options 

These options change the way labels appear. 

   Using the page layout 

editor 

The label layout editor is where you specify label dimensions, label gaps, 

page margins, and overall column/row layout criteria. 



Compleat Botanica - Basic steps for printing labels

 Using the software    Printing    Labels   

Here's an overview of what it takes to prepare and print labels.

Step 1:  Selecting which labels to print

You can use two different methods to select which 

specimen to include on your labels. One method uses your 

currently selected filter, the other method uses the "Tag 

needs printing" column.

If you're comfortable creating and using filters, you'll find 

this to be a powerful way to select exactly which specimen 

to include. You can use any existing filter or you can create 

a new one just for the purpose of selecting which records to 

include on your labels. Use the normal methods for 

defining and selecting your filter, then proceed to Step 2.

If you want to quickly print labels for just a few of your specimen, 

you'll find the second method to be fast and straightforward. Go to the 

Herbarium View and check the box named "Tag needs printing" for 

each specimen to be printed.

Note that each new specimen record that you create automatically has 

this box checked making it convenient for you to print labels for all 

your new entries.

Step 2:  Print command

Begin the print process by choosing the Print Labels command from the File menu.



Step 3:  Modify an existing label format

Choose one of the predefined label formats as a template for your own custom label layout. Double-click on the item to modify the layout, 

formatting, and printing options. See the document Choosing a label format for snapshots of a few of the pre-installed layouts.

Step 4:  Check your printing options

Choose whether to print all pages or a From and To range of pages.



Use the Missing labels option to re-use a sheet of labels that's 

already been partially been used.  See WYSIWYG label preview for 

more about this.

If you have more than one printer, select which one to 

use.  Use the Print setup button to change special 

printer characteristics.

Step 5:  Press the Print button

Load the sheets of labels in your printer's tray and press the print button.

You'll also want to read the special Tips for setting up accurate label 

layouts. 

 



Compleat Botanica - Tips for setting up accurate label layouts

 Using the software    Printing    Labels   

At first glance everything looks straightforward, but there are a few things about printing labels that may not be so 

obvious. Here are some tips for setting up and printing labels.

1

The size and layout of each sheet of labels is determined by six things: 

●     Paper size. The overall dimensions of the sheet of labels. If you live in the USA this will most likely 

be "Letter size" or 8.5" by 11.0". If you live in any country which uses ISO paper sizes this will 

most likely be "A4" or 210mm x 297mm.

●     Orientation. Whether the labels are laid out in portrait or landscape mode. Most sheets of labels 

are oriented as portrait.

●     Label layout. The number of labels across the page and the number of labels down the page.

●     Page margins. The amount of space reserved for your printer to grab the sheet and pull it through 

the device. This is unprintable space.

●     Label dimensions. The width and height of each label.

●     Spacing between labels. The amount of space between each row of labels and between each 

column of labels. Many sheets of labels are arranged so that each label is adjacent to its neighbors; 

you'll specify zero for these types of labels.

2 The "scale" affects only the on-screen print preview, not the actual paper printing size.

3

When printing labels using the "Selected specimen" option, the sorted order of labels is the same as the 

sorted order in your Specimen List.  To read more about sorting see the document Sorting the list of 

specimen.

When printing labels using the "Tag needs printing" checkbox, the sorted order of labels is alphabetical by 

botanical name.
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4
To add additional spacing between two lines of text on your labels you can add an extra line with no text. 

Simply use the "font size" to adjust the size of this blank line and thus the amount of blank spacing between 

your lines of text.

5 Portrait and Landscape are controlled by the Orientation item on the Print Preview, not by the settings of 

your printer.

6 The list of fonts shown in the Design Label window are the fonts available for the selected printer.  If the 

list of fonts seems too small, make sure you haven't selected a "Generic / Text Only" printer.

7 When using the "Tag needs printing" option, you can choose to automatically clear the checkbox when the 

labels have been satisfactorily printed.

 



Compleat Botanica - Choosing a label format

 Using the software    Printing    Labels   

When The Compleat Botanica is installed, several sizes of label layouts are predefined.  

These layouts demonstrate a variety of different styling and formatting possibilities. Use 

them as templates to get started with your own custom labels.

Once you see how the predefined label layouts have been constructed, you'll want to 

experiment with fonts, colors, column values, and so forth.  Remember, what you see is 

what you get, so prepare your labels first using the on-screen previewer, and there will be 

no suprises when the finished labels roll off the press.

A few snapshots are shown here to help you visualize the possibilities. Each of these are 

shown at 100% scaling with the bottom half of the page clipped off.

 

Report 

style
Sample

20 x 4



10 x 3



7 x 2



4 x 2



2 x 1



 



Compleat Botanica - WYSIWYG label preview

 Using the software    Printing    Labels   

The Label Preview window is a "what you see is what you get" (WYSIWYG) display.  Using the label preview enables you 

to precisely see how each sheet of labels will look when printed.

There are several features which make the label preview useful:

1

The up and down scrolling buttons allow you to see 

each of the label sheets to be printed.

Tip:  To continuously scroll, press and hold the 

button down until you reach the desired page. 

 

The page scale feature allows you to see more or less 

of the sample layout on your screen.  Remember also 

that the entire label preview window can be sized 

larger or smaller just like any other sizable window. 

The whole page option scales the preview so that 



2 you can see the complete page within the window.  

The page width option scales the preview so that 

you can see the entire width of the sheet of labels 

within the window.  The page height option scales 

the preview so that you can see the entire height of 

the sheet of labels within the window.

3

 

The paper size selector lets you choose the size of the 

label sheets that are in your printer. You should 

make this selection before setting up the dimensions 

of each label because adjusting the paper size will 

automatically adjust the size of the labels to fit on 

the page.

 



4

 

When using paper with a custom size, use the width 

and height items to match your paper's dimensions.

If you want to specify your dimensions in US 

Customary units (inches) or metric units 

(millimeters), you can use the Customize Setting 

window to change how units are specified. See the 

document Choosing measurement units for reports 

and labels.

 

5

 

Your report's orientation is set using this print 

preview feature; it is not set using the portrait/

landscape option under printer settings. Most sheets 

of labels are portrait. Note that changing this 

selection will automatically adjust the size of the 

labels to fit the page, so you'll want to make this 

selection before specifying your label layout options.

 

6

 

You can reuse a sheet of labels that has already been 

partially used by specifying how many labels are 

missing. Missing labels are shown with a light gray 

outline in the preview window.
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7

 

Labels can be arranged to go across the page or 

down the page.

 



Compleat Botanica - Defining label text and data values

 Using the software    Printing    Labels   

Use the Design label 

window to specify text and 

data values to include on your 

labels. You can specify text that appears on each label exactly as typed, or you can specify data values that are separately 

pulled from your specimen list for each label.  Data values are specified by entering one of the replacement tags that follow 

the form: <cb:xxxxx>. See the Alphabetical index to column specifications for the names used in these replacement tags.

1
Each line of the label is specified with 

a separate format line.
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2
 

To show the list of data values that can be added to the 

label, press the Insert Columns button. Double-click 

an item in the list to add it's special replacement tag to 

the label.

3

Enter both the replacement tags and your special text in this part of the window. Note that a single line can contain a 

mixture of text and data, including multiple data items. A sample of how the line will appear on the label is shown at 

the very bottom.

 



Compleat Botanica - Defining label fonts and colors

 Using the software    Printing    Labels   

Using the Design label 

window you can change the 

fonts and colors used on each 

line of the label. Here's an explanation of the options available.

*

To change the font characteristics for 

one line, choose that line using the 

list shown here.  To apply changes to 

two or more lines simultaneously, 

use the <Ctrl> key on your keyboard 

to select multiple lines.  To apply 

changes to all lines, choose the <All 

lines> item.

You can add as many lines as you 

want to each label.



*

The list of fonts is grouped into four 

font types: sans serif fonts, serif 

fonts, script fonts, and special fonts.  

The blue symbols in the list indicate 

the font type. 

The font names shown in this list is 

based on which printer you've 

selected.  If you don't see very many 

fonts, make sure you haven't selected 

"Generic / Text only" as your 

destination printer.

* Font sizes range from 6 points to 72 

points.



* 

When printing to color printers, use 

any of the standard text colors. 

When printing to black and white 

printers, choose from the gray 

palette.

*

Note that not all fonts have bold and 

italic.  Choose a font style available 

for your selected font.

 

*
Align the text within the label.



*

Use the word wrap option when a 

single line item is allowed to span 

multiple lines on the label. This is 

also useful when you specify more 

than one data value on the same line 

and you want to have the appearance 

of a paragraph.

*

See Defining label text and data values for an overview of the options available for text entry.

 



Compleat Botanica - Choosing label options

 Using the software    Printing    Labels   

By using the Label options 

tab in the label format editor 

you can make changes to the 

overall appearance of your labels.  Here's what you can do:

*
Choose either color or black and white.  When black 

and white is chosen, only shades of gray are available 

in the Design label window.

*

Label margins are the non-printing portion of each 

label.  You can specify these values using US 

Customary units (inches) or metric units (millimeters) 

by making your choice in the Customize Setting 

window. See the document Choosing measurement 

units for reports and labels.

*

When printing to plain paper instead of to actual 

labels, you may want to check the Show label 

outline when printing checkbox. This will print the 

background shading and outline of the simulated label. 

This is especially useful when printing placards that 

are intended to be laminated. 
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*

This summary area shows the amount of space 

available for each label. This is calculated by taking 

into consideration the label's dimensions less the non-

printable margins. 

 



Compleat Botanica - Using the page layout editor

 Using the software    Printing    Labels   

The Page layout editor is 

where you specify label 

dimensions, label gaps, page 

margins, and overall column/row layout criteria. Before making changes here, be sure to set your paper size and orientation 

in the Show preview window because they control the total amount of space available for printing. To obtain accurate 

label layouts, a ruler is helpful in determining precise dimensions.

Note that dimensions are stored internally using points. A point is defined as 1/72 of an inch. Points are further divided into 

20 units called twips. When values are specified in the page layout editor they are coverted from millimeters or inches into 

twips and stored with a precision of 1440 twips per inch or approximately 567 twips per millimeter.

*
Begin by entering the number of labels that each 

sheet contains.

*

The outer portion of each sheet of labels is 

reserved for the printer to use in grabbing the 

sheet and pulling it through the device. Specify 

each of these values here.

The auto-adjust button is useful in determining 

these values if you've already specified both the 

label dimensions and the label spacing.



*

When you purchase your labels, the manufacturer 

will supply you with the dimensions for each label. 

Enter the width and height of a single label here.

Most label dimensions can easily be entered here, 

but some labels are specified with widths or 

heights that are irrational numbers (numbers 

whose precision goes on forever such as 0.3333). 

For these types of dimensions, enter the nearest 

rational number. If you are using metric units the 

nearest value will be to a precision of 1/10 of a 

millimeter. If you are using US Customary units 

the nearest value will be 1/32 of an inch. For 

example, a label dimension of 2 1/3" can be 

entered as 2 11/32".

The auto-adjust button can be used if you've 

already specified both the page margins and the 

label spacing.

*

The amount of space between labels is the gap 

between adjacent columns or adjacent rows of 

labels. Many sheets have labels that are placed 

directly adjacent to each other; you'll enter zero in 

this area for those types of labels.

The auto-adjust button can be used if you've 

already specified both the page margins and the 

label dimensions.

*

The amount of available space is the remaining 

space on the page that needs to be accounted for 

somehow. Press one of the autoadjust buttons to 

evenly divide this unaccounted for space. When 

everything is in order these values should both be 

zero. If a value is negative, then you've probably 

specified label dimensions that are too large for the 

page or you've indicated an incorrect number of 

labels per column / labels per row.

Occasionally there will be a tiny fraction of 

unaccounted for space remaining. This sometimes 

happens when the number of labels across or down 

is an odd number instead of an even number. Test 

print a single sheet of these labels to be sure that 



the layout is close enough to be acceptable.

 



Compleat Botanica - Choosing which labels to print

 Using the software    Printing    Labels   

The Choose specimen tab is 

where you'll choose which 

specimen to include with your 

labels. There are two methods for making your choice -- one method uses the current filter, the other method uses the "Tag 

needs printing" checkbox.

This is also where you'll make your selection of how many labels to print for each specimen included in the layout.

*

For a general discussion on selecting which labels to 

print refer to the Basic steps for printing labels 

document.

If you choose the Tag needs printing method, your 

labels will include only those specimen with that box 

checked.  See the Herbarium View for a snapshot 

showing where to find this checkbox.

If you choose to use the selected specimen method, 

your labels will include only those specimen that meet 

the criteria of the currently selected filter.  (These are 

the items shown in the Specimen List when you started 

the Print Labels operation.) 

*

There are two ways to specify how many labels to print 

for each specimen. One way is to use the Quantity 

item.  See the Garden View for a snapshot showing 

where to find this item. If you use this item, each 

specimen will have a different number of labels 

printed. Note that no labels will be printed for any 

specimen whose Quantity item is blank.

The second way to specify how many labels to print is 

to enter a number in the Print this many item. Using 

this option, each specimen will have the same number 

of labels printed.
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*

The summary area gives you some feedback on the 

number of labels to be printed. The Number of 

labels to print will be an even multiple of the 

Number of specimen to print when you use the 

second option for specifying quantities. If you use the 

first option, either of these two quantities could be 

much greater or much less than the other.

It's especially important to check this summary area 

when using the Tag needs printing or Quantity 

options since you'll often find surprises with these 

options.

 



Compleat Botanica - Printing Pathfinder documents

 Using the software    Printing    Documents   

Index to printing Pathfinder topics

   General instructions for 

printing Pathfinder 

documents 

Printing documents from within the Pathfinder View is easy. Just select the 

Print document option from the File menu. 

 



Compleat Botanica - General instructions for printing Pathfinder documents

 Using the software    Printing    Documents   

Printing 

documents from 

within the 

Pathfinder View is 

easy.  Just select 

the Print 

document 

option from the 

File menu. 

Only one 

document at a 

time can be 

printed.  

Pathfinder 

documents make 

extensive use of 

hyperlinks to 

allow easy 

navigation from 

one topic to 

another.  Printing 

the entire set of 

Pathfinder 

documents with a 

single command 

is not supported.

The options and 

layout of this 

Print window will 

vary depending 

on which 

operating system 

and which version 



of Microsoft 

Internet Explorer 

is installed on 

your computer. 

  

Printing options are controlled by Microsoft Internet Explorer

To change printing options, 

start Microsoft Internet 

Explorer and go to the 

Internet Options menuitem 

under the Tools menu.

 



Here's where you can change 

the option to print background 

colors and images. 

The Pathfinder documents use 

background colors to make 

reading documents online 

easier, but printing 

background colors can use a lot 

of color ink cartridges.

Printing background colors 

may be necessary in order to 

see white text (such as titles) 

on a white sheet of paper.

 



Compleat Botanica - Printing Checklist reports

 Using the software    Printing    Checklist   

Index to printing Checklist reports

   General instructions for 

printing checklist reports 

Checklist reports are a simple alternative to the more sophisticated 

specimen reports. 

   Preparing checklist 

reports 

Checklist reports provide a simple way for you to look at hierarchical listings 

of plant names. 

   Previewing checklist 

reports 

The checklist report generator and previewer is simple and straightforward. 

 



Compleat Botanica - General instructions for printing checklist reports

 Using the software    Printing    Checklist   

Overview

Checklist reports are a simple alternative to the more sophisticated specimen reports. Although simple, they can provide an 

interesting snapshot of both your collection and the Plant Kingdom at large.

Restrictive or General

 Checklist reports can be 

prepared in a restrictive 

way or in a general 

purpose way. Restrictive 

reports include only 

names for which you have 

specimen entries. This 

type of report is useful for 

seeing the diversity or the 

concentration of your 

collection. The report 

shows a colored 

checkmark symbol for 

each name that is in your 

specimen collection.

On the other hand, 

general purpose reports 

include all of the 

taxonomic names found 

in the checklist without 

regard to your specimen 

collection. This type of 

report is useful for seeing 

your collection in the 

shadow of the Plant 

Kingdom.



Hierarchical or Flat

Checklist reports 

can also be 

printed in two 

different fashions: 

hierarchical or 

flat. Hierarchical 

reports begin with 

the supra-ranks of 

a given name and 

proceed down the 

hierarchy to a 

particular level. 

For example a 

hierarchical 

report for the 

genus Lavandula 

would show 

Magnoliophyta > 

Rosopsida > 

Lamiales > 

Lamiaceae (and 

the intermediate 

sub-taxa) before 

listing the species 

of the genus.

Flat reports list 

the named 

members of a 

rank without 

including any 

supra-ranks. This 

type of report can 

be useful in 

preparing a list of 

all family names, 

or all names of 

some other rank.

A combination 

report can also be 

created. These 

show all names of 

a given rank and 

further include 

 



names of sub-

ranks down to a 

particular level.

By choosing 

restrictive or 

general and 

hierarchical or 

flat, you can 

produce a variety 

of simple reports 

that are 

informative and 

useful.

Getting started

Begin by displaying the Checklist View, then select the 

Print checklist option from the File menu.

Follow the detailed instructions in Preparing checklist 

reports.

 

 



Compleat Botanica - Preparing checklist reports

 Using the software    Printing    Checklist   

Checklist reports provide a simple way for you to look at hierarchical listings of plant names. These are not a 

replacement for the more powerful specimen reports, but they do provide printed information in a useful layout. 

Checklist reports are based on the data which is stored in the Checklist View, and because of this provide no individual 

specimen details.

Here's how the features of the Print checklist window are interpreted and used by the software:

*

By choosing the option to print 

Only entries with "specimen 

available" you're instructing the 

report generator to produce a 

restrictive report. This type of 

report is useful for seeing the 

diversity or the concentration of 

your collection.

The "specimen available" checkbox 

of the Checklist View is 

automatically updated for each 

entry you add to your collection.



*

By choosing the All checklist 

entries option, you're instructing 

the report generator to include 

taxonomic names for everything in 

the Checklist View, even if your 

personal collection has no 

corresponding entries. This type of 

report is useful for seeing your 

collection in relationship to the 

entire Plant Kingdom.

* By choosing the Print hierarchy starting at X option you're instructing the report generator to begin 

with the supra-ranks of a given name and proceed down the hierarchy to a particular level. To use this 

option, you must select which item in the Checklist you want to create the report for before showing this 

print window. The name shown in place of the "X" is the starting point for the report.

 

*
By choosing the All members starting with rank option you're instructing the report generator to list 

the named members of a rank without including any supra-ranks. This type of report can be useful in 

preparing a list of all family names, or all names of some other rank. Choose which rank to list in the report 

using the adjacent droplist.

When using this option, be sure to carefully choose the Include all ranks to this level option (see next 

item below for a description). Usually, you'll want to choose the same rank here and in the droplist above. 



It's possible though to produce meaningful reports using various combinations of these two.

 

*

In the list to Include all ranks down to this 

level you're instructing the report generator where 

to stop its listing. Choose the lowest rank in the 

hierarchy to include. When producing lists of your 

own collection you might like to set this at species 

or sub-species -- this will produce a good list of your 

specimen.

When producing lists of the entire taxonomic 

checklist, you should carefully set this. Setting it too 

low can easily produce a report that is hundreds of 

pages long!

 

*

Include outline numbers. Turns on the 

numbering of each item. Each sub-rank in the 

hierarchy starts all over again with the number "1".

Include rank. Prints the rank for each name 

(something like "classis", "ordo", "familia", "genus", 

"species", etc.)

Include author. Prints the name of the person 

who wrote the official description of the plant.

Include publication. Prints the name of the book 

or journal where the official description of the plant 

was first published.

Include synonym. Prints the true name of the 

item if this item is a synonym.

Include vernacular names. Prints the common 

name as well as the botanical name.



Include symbols. Prints a red checkmark for any 

name which has the "specimen available" box 

checked. Prints a blue checkmark if the name is of 

rank species. 

After choosing which options you want for the report, you can generate a preview of it by 

pressing the Preview button. See Previewing the checklist report for more about this.

 



Compleat Botanica - Previewing checklist reports

 Using the software    Printing    Checklist   

The checklist report generator and previewer is simple and straightforward.

*

After choosing your 

options and pressing 

the Preview button 

(on the previous 

window), you'll see a 

window like this one 

that monitors the 

progress of the report 

generation. Simple 

reports can be 

produced quickly. 

More complicated 

reports can take a long 

time to produce. Wait 

for the message that 

indicates the report is 

finished being 

prepared, then press 

the Preview button to 

continue.

*

Use the preview 

window to decide if 

this is the report as 

you want to see it. If 

not, close the window 

and change your 

options.



The actual printing operation is handled by the built-in Internet Explorer browser. This means that page breaks and final page 

layout may be slightly different from what you see in the preview window.

 



Compleat Botanica - Sharing your data

 Using the software    Sharing   

Index to import/export topics

   Importing from other 

applications 

Index to topics about how to import data from other 

applications. 

   Exporting data to other 

applications 

Index to topics about how to export data to other applications. 

   Data validation and import/export 

rules 

Index to topics on data validation and import/export rules. 

 



Compleat Botanica - Importing from other applications

 Using the software    Sharing    Importing   

Index to importing topics

   Overview of how to 

import specimen 

Specimen records may be added to your database by importing data from 

another Compleat Botanica database or from a general purpose database 

that supports delimited files. 

   Steps for importing 

specimen from XML files 

To begin the XML import process for Specimen, be sure your current view is 

one of the five specimen views. 

   Steps for importing 

specimen from delimited 

files 

To begin the delimited file (CSV,TXT) import process for Specimen, be sure 

your current view is one of the five specimen views. 

   Importing Category 

records 

Importing category records is handy if you’ve created a collection of 

categories in one database and you want to copy theminto a new database. 

   Importing 

Filters 

You may want to import a filter from another computer rather than re-

entering it manually. 

   Importing Taxonomic 

records 

Importing taxonomic records is an advanced feature for those whose want to 

use a different family / order / class hierarchy system. 

 



Compleat Botanica - Overview of how to import specimen

 Using the software    Sharing    Importing   

Specimen records may be added to your database by importing data from another Compleat Botanica database or from 

a general purpose database that supports delimited files.  A delimited file is sometimes referred to in general terms as 

an ASCII file.  Delimited files follow these three rules:  1) they have one line of text per specimen record, 2) each line of 

text is broken into columns where either a tab or a comma separates each column, and 3) the first line of text contains 

the names of the columns and subsequent lines contain the records.

The import process can check for duplicate entries in the database and can proceed in one of four ways: duplicates can 

be merged with the existing record, they can be skipped entirely, they can be replaced entirely, or they can be created 

without regard to the existing record.  Duplicates are determined by matching import records to existing records based 

on either the botanical name or the specimen number.

To understand how the data files are processed, what the column names are, and what special formatting rules apply to 

each column, refer to the documents for each individual column. See the Alphabetical index to column specifications.

To see snapshots of the screens you will encounter during the import process, see the documents:

●     Steps for importing specimen from XML files

●     Steps for importing specimen from delimited files
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Compleat Botanica - Steps for importing specimen from XML files

 Using the software    Sharing    Importing   

To begin the import process for Specimen, be sure your current view is one of the specimen views.  From the File menu select the Import command.

 

Use the “Select data file” 

window to choose the 

XML file containing 

specimen records to be 

imported. See the file 

Specimen.xml for a 

sample of a valid XML file.

For a complete list of 

tagged values that can be 

used in the XML file see 

the document type 

definition contained in 

CompleatBotanicaSchema.

xml.

For validation rules used 

by the XML import parser 

see the documents 

referenced in the 

Alphabetical index to 

column specifications.

 

Press the Next button.

1

Select one of the four 

possibilities for dealing 

with records that are both 

in the XML file and in 

your database.

For the bottom three 

possibilities, you will also 

need to select how records 

in the database are 

compared with records in 

the XML file.

2
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Press the Next button. 

Press the Start button to 

import the records. 3



Compleat Botanica - Steps for importing specimen from delimited files

 Using the software    Sharing    Importing   

To begin the import process for Specimen, be sure your current view is one of the specimen views.  From the File menu select the Import command.

 

Use the “Select data file” 

window to choose the 

comma separated file or 

the tab delimited file 

containing specimen 

records to be imported. See 

the files Specimen.csv and 

Specimen.txt for samples 

of valid delimited files.

For a complete list of 

column names and their 

validation rules see the 

documents referenced in 

the Alphabetical index to 

column specifications.

 

Press the Next button.

1

 

Select one of the four 

possibilities for dealing 

with records that are both 

in the delimited file and in 

your database.

For the bottom three 

possibilities, you will also 

need to select how records 

in the database are 

compared with records in 

the delimited file.

 

2
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Press the Next button. 

Press the Start button to 

import the records.

3



Compleat Botanica - Importing Category records

 Using the software    Sharing    Importing   

Importing category records is handy if you’ve created a collection of categories in one database and you want to copy them into a new database. To begin the 

import process for Categories, be sure your current view is the Category View. From the File menu select the Import command.

Use the “Select file” 

window to choose the 

XML file containing 

category records to be 

imported. See the file 

Category.xml for a sample 

of a valid XML file.

For a complete list of 

tagged values that can be 

used in the XML file see 

the document type 

definition contained in 

CompleatBotanicaSchema.

xml.

 

 

 

Press the Next button.

1 

 

 

 

Press the Start button to 

import the records.

2 

file:///V|/ActiveProjects/CrescentBloom/www/PoxyPDF/I/J/Category.xml
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Unlike the Import Specimen operation, the Import Category operation always deals with duplicates the same way. Categories in the database and in the XML file 

are matched by category code. If they are the same, the values in the XML file are merged with the values in the database. On the other hand, if the XML file 

contains a category that does not exist in the database, it is added.

 



Compleat Botanica - Importing Filters

 Using the software    Sharing    Importing   

You may want to import a filter from another computer rather than re-entering it manually. To begin the import process for filters, be sure your current 

view is the Filter View.

 

Use the “Select 

file” window to 

choose the XML 

file containing 

filter to be 

imported. See the 

file Filter.xml for a 

sample of a valid 

XML file.

 

Press the Next 

button.

1 

 

Press the Start 

button to import 

file:///V|/ActiveProjects/CrescentBloom/www/PoxyPDF/I/J/Filter.xml


the records.

 

2 

 



Compleat Botanica - Importing Taxonomic records

 Using the software    Sharing    Importing   

Importing taxonomic records is an advanced feature for those whose want to use a different family / order / class hierarchy system. The system employed by The 

Compleat Botanica is somewhat different from the recognized systems of Cronquist, Walters & Keil, or others. For more about this see All about family names. 

To begin the import process for taxonomic records, be sure your current view is the Checklist View.

Before starting, select the 

record in the taxonomic 

hierarchy that will 

become the parent of the 

imported records.

After selecting the parent 

record, begin the import 

process by choosing the 

Import command from 

the File menu.

1 

Use the “Select file” 

window to choose the 

XML file containing 

taxonomic records to be 

imported. See the file 

Taxonomic.xml for a 

sample of a valid XML file.

For a complete list of 

tagged values that can be 

used in the XML file see 

the document type 

definition contained in 

CompleatBotanicaSchema.

xml.

 

Press the Next button.

2 

file:///V|/ActiveProjects/CrescentBloom/www/PoxyPDF/I/J/Taxonomic.xml
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Press the Start button to 

import the records. 3 



No checking is done for duplicate records; thus everything in the XML file is guaranteed to be imported. If you need to merge selected data into existing 

taxonomic records, you should first export the hierarchy, then make your changes to the XML file, and finally import the modified XML file.

 



Compleat Botanica - Exporting data to other applications

 Using the software    Sharing    Exporting   

Index to exporting topics

   Exporting Specimen 

records 

Instructions for exporting specimen records from The Compleat Botanica. 

   Exporting Category 

records 

Instructions for exporting category records from The Compleat Botanica. 

   Exporting Taxonomic 

records 

Instructions for exporting taxonomic records to make large scale changes to 

the hierarchy. 

   Exporting 

Filters 

You may want to export a filter so that it can be used on another computer, 

or as a preparatory step to upgrading your software. 

 



Compleat Botanica - Exporting Specimen records

 Using the software    Sharing    Exporting   

To export specimen records be sure your current view is one of the specimen record views.  Select which filter you want to apply to your data before you begin 

the export process.  

 

If you only want to 

export some of the 

records in the current 

filter, select them 

(using the <Ctrl> key 

and the mouse) 

before starting the 

export process.

1 

Use the “Select file” 

window to enter the 

filename where you 

want the exported 

records to be placed.

Press the Next 

button.

2 



Answer two questions 

on this window:

1. Do you want to 

export all records of 

the current filter or 

just the ones selected 

(as shown in the first 

step above)?

2. Do you want to 

export the columns as 

specified in the 

current filter, or all 

columns in the 

database?

3 



Press the Start 

button to export the 

records.

4 

 



Compleat Botanica - Exporting Category records

 Using the software    Sharing    Exporting   

Exporting category records is most useful in conjunction with its twin, “importing category records”. You’ll want to use this pair of functions when 

moving data from one computer to another. To begin the export process for categories, be sure your current view is the Category View. From the File 

menu select the Export command.

First select which 

group of category 

records you want 

to export.

Select the root of 

the hierarchy to 

export all 

categories.

1 

Use the “Select 

file” window to 

type in the name 

of the file where 

you want to put 

the category 

records. All 

output files are in 

XML format.

Press the Next 

button.

2 



Press the Start 

button to Export 

the records.

 

3 



 



Compleat Botanica - Exporting Taxonomic records

 Using the software    Sharing    Exporting   

Exporting taxonomic records is useful if you want to make large-scale changes to the family / order / class hierarchy system. If this is what you need to 

do you can export all or part of the Checklist to an XML file. After exporting you can use a file editor to make global changes to the individual records. 

Finally, you can use the import command to bring the changed records back into the database.

To begin the Export process for taxonomic records, be sure your current view is the Checklist View.

Before starting, 

select the highest 

record in the 

taxonomic 

hierarchy that you 

want to export.

 

After selecting the 

highest record, 

begin the Export 

process by 

choosing the 

Export command 

from the File 

menu.

1 



Use the “Select 

file” window to 

specify the name 

of the file to be 

used for the 

exported records.

Press the Next 

button.

2 

Decide whether 

you want to 

export a single 

record or the 

entire hierarchy 

of subordinate 

taxa.

Press the Next 

button. 

3 



Press the Start 

button to Export 

the records.

4 



 



Compleat Botanica - Exporting Filters

 Using the software    Sharing    Exporting   

You may want to export a filter so that it can be used on another computer, or as a preparatory step to upgrading your software. To begin the Export 

process for filters, be sure your current view is the Filter View.

 

Use the “Select 

file” window to 

specify the name 

of the file to use 

for the exported 

filter. This file will 

be in XML format.

Note that this 

XML file cannot 

be used directly 

from within the 

“Filters” 

subdirectory, you 

must use the 

Import command 

to bring it into the 

new computer.

Press the Next 

button.

1 

Press the Start 

button to Export 



the filter. 2 

 



Compleat Botanica - Data validation and import/export rules

 Using the software    Sharing    Rules   

Index to validation topics

   XML 

viewers 

The Import and Export commands use XML files to transfer data into and 

out of The Compleat Botanica. 

 



Compleat Botanica - XML viewers

 Using the software    Sharing    Rules   

The Import and Export commands use XML files to transfer data into and out of The Compleat Botanica. Although most newer applications can use this file format 

directly, there may be times when you’ll want to edit XML files yourself. This can be done using any simple editor like Notepad. Here’s what an XML file looks like 

when viewed with Notepad.

 

For a more sophisticated tool you may want to get a special XML editor. One such tool is Microsoft’s XML Notepad. Here’s what it looks like when the Compleat 

Botanica file Specimen.xml is opened.

file:///V|/ActiveProjects/CrescentBloom/www/PoxyPDF/I/J/Specimen.xml


 



Compleat Botanica - Publishing your data

 Using the software    Publishing   

Index to publishing topics

   Step-by-step guide to 

publishing 

Before you begin the publishing process, be sure to select the filter that you 

want to apply to your data. The selected filter will be used by the publish 

process to select which records to include. 

   The publish 

previewer 

As you go through the step-by-step publishing process you can see what 

your finished publication will look like by using the Publish Preview feature. 

   How the publishing 

parser works 

The step-by-step publishing process is all you need to know in order to 

produce great looking labels, abstracts, Web pages, pre-press books, and 

more. 

   Publication style 

sheets 

Each published document references three style sheets: cbs-colorscheme.

css, cbs-fontface.css, and cbs-pointsize.css. 

   Publication template 

replacement tags 

Replacement tags inside publishing templates take the form <cb:

TagName>. 

 



Compleat Botanica - Step-by-step guide to publishing

 Using the software    Publishing   

Step 1:  Select a filter

Before you begin the publishing process, be sure to select the filter that you want to apply to your data.  (See All about 

filters). The selected filter will be used by the publish process to select which records to include.  Many of the templates also 

make use of the selected filter to decide which columns to publish.  For example, all of the publishing templates described as 

"Columns of the current filter", will publish only the columns of specimen data which are part of the selected filter. 

Step 2:  The publish command

From the File menu, select the Publish specimen command.  Note that 

this menu item is only available when one of the Specimen Views is active. 

Step 3:  Choose the publishing mode

There are two basic types of documents that can be created using the publish tool:  detailed pages and summary pages.  Both 

can use any of the specimen data fields, and both use any combination of style sheets to produce sophisticated layouts with 

colors, fonts, and graphics.  Detailed pages contain the data for exactly one specimen record, whereas summary pages 

contain the data for all specimen. 
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Detailed pages are useful for creating nursery 

placards, web pages, and book layouts.  

Summary pages are useful for creating 

indexes, table of contents, photo proof sheets, 

labels, and abstracts.

When choosing which publishing mode to use, remember that the summary page mode will produce exactly one document, 

while the detailed page mode will produce multiple documents. 

If you want to produce an index or table of contents together with hyperlinks to more detailed pages, choose the third 

publishing mode. 

Step 4:  Choose which specimen to publish

If you want to publish only a few of your specimen 

records, you can use the multiple-selection feature of 

the Specimen List together with the "Publish the 

selected specimen only" option.  This is also useful 

when you simply want to print or publish a single 

specimen record.

Typically though, you'll want to "Publish all specimen 

of the current filter".  Remember to select the proper 

filter before you begin the publish process.

Step 5:  Choose styles to use

Four different types of styling can be applied to your published documents:  color schemes, font styles, font sizes, and logos.
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The color scheme applies a 

combination of two or three basic 

colors to your published 

document.  Each scheme sets the 

font colors, background colors for 

tables, and line-break colors.

The font style defines which 

combination of fonts will be 

applied to your documents.  Some 

styles apply the same font 

throughout. Some apply one font 

for labels and another for data 

values.  Others set specific fonts 

for titles. 

When publishing to the Web, it's 

best to use the Web compatible 

font styles.  When your publishing 

results are intended to be printed 

it's better to use the "Paper" styles.

Choose any available font size.  Note that most of your document will use this font 

size but some will be slightly larger (titles) or smaller (footers).



Choose any of the pre-supplied logos.  To add you own logo to this list, simply 

copy a GIF format picture file to the directory  "C:/Program Files/
CompleatBotanica/Programs/Publish Templates/Style Sheets/

Logos" and it will appear in this list.

To see a sample of your selected styles, press the Show Sample button.  You can keep 

this publish preview window open as you proceed through the remaining steps of the 

publish process. 

Step 6:  Choose summary table template

Note:  The "Choose summary table template" step is not shown if you picked "Publish one detailed page per specimen 

record" in step 3.

There are several categories of summary table templates.  Select a category 

on the left hand side to see the associated templates on the right-hand 

side. 

When publishing to the Web, be sure to use a summary table template that 

has hyperlinks, since those templates are specifically customized for 

creating links to the detailed documents.  See the templates under "Table 

of Contents" and "Web site indexes".



 

Step 7:  Choose detailed page template

Note:  The "Choose detailed page template" step is not shown if you picked "Publish a single page summarizing all 

specimen" in step 3.

There are several categories of detailed page templates.  Select a category 

on the left hand side to see the associated templates on the right-hand 

side. 

When publishing to the Web, be sure to use one of the custom tailored 

templates that have hyperlinks for navigating to the previous and next 

pages (look under "Web pages").

 

Step 8:  Select output directory



Choose where you want the newly-created documents to 

be placed.  If the selected directory already has 

documents from a previous publication process, you can 

choose whether to overwrite them or not. 

Document files are given a filename corresponding to 

their "Specimen number".  Thus a detailed page for 

specimen number "S101" would be published in the 

document "S101.htm" and any pictures and bitmaps 

would be copied to the sub-directory "S101_files".

The document name for the summary table of all 

specimen is always "index.htm" 

If you choose to overwrite existing documents from a 

previous publication process, the standard document 

names will be re-used (see above). 

If you choose not to overwrite existing documents, the 

newly-created documents will be given artificial names 

like "1.htm", "2.htm", etc.

Step 9:  Start the process

Simply press the start button to begin. 



The progress of the publication process 

is shown in as each specimen document 

is created.  (The "index.htm" file 

always takes longer than the individual 

detail pages.) 

Use the Show button when the process 

is complete to see your published pages 

in the publish preview window. 

Since your finished pages are standard HTML files, you can use any Web browser or Web publishing tool such as Front 

Page, to display and print your finished documents.  You can also further edit them to create special effect or to touch-up the 

generated documents. 

 



Compleat Botanica - The publish previewer
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As you go through the step-by-step publishing process you can see what your finished publication will look like by using 

the Publish Preview feature.  This button is available from steps 5, 6, 7, and 9 as described in the Step-by-step guide to 

publishing.

The six buttons at the top of the window have the following use:

  

Button Usage

Prev
Navigate to the previous HTML document.  Note that this is only useful when viewing the finished 

publication as produced by step 9.

Next
Navigate to the next HTML document.  Note that this is only useful when viewing the finished 

publication as produced by step 9.

Front Keep the publish preview window on top of all other windows.

Back
Place the publish preview window behind other windows when it isn't the active window.  This is the 

normal behavior for windows.

Print Print the currently displayed document

Close Close the publish preview window

  



 

 



Compleat Botanica - How the publishing parser works
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The step-by-step publishing process is all you need to know in order to produce great looking labels, abstracts, Web pages, pre-press books, and more.  But if 

you're familiar with HTML you can customize every aspect of your final publication.  This page describes how.

At the heart of The Compleat Botanica publishing process is the parser.  The parser's role is to take HTML templates, to replace special keyword tags with data 

from the database, and to create new HTML documents with the user's selected style sheets.  Conceptually there are three inputs and one output to the 

process.  It looks like this:



 

Input 1:  Current filter 

The first of the three inputs to the parser is the currently selected filter.  This determines which records to publish and in some cases also determines which 

columns to publish.  Use the usual process for defining and selecting a filter to show only the records and columns that you want to publish. 

Input 2:  Style sheets 

The second of the three inputs are the style sheets.  Each published document references three style sheets:  cbs-colorscheme.css, cbs-fontface.

css, and cbs-pointsize.css.  When the user selects a color scheme using the step-by-step process, the publish parser copies the selected scheme to the 

well-known filename "cbs-colorscheme.css" in the publication directory.  Similarly, the selected font style is copied to "cbs-fontface.css" and the 

selected point size is copied to "cbs-pointsize.css". 

Although it is not actually a style sheet, the selected logo is pre-processed the same way as the other three style sheets: the selected logo file is copied to the 

well-known name "images/logo.gif" in the publication directory. 

The source files for the three types of style sheets and the logo files can be found under the "Publish 

Templates" directory.  By modifying any of the pre-defined style sheets you can customize the 

overall appearance of the documents created.  See the document on Publication style sheets for 

more about this. 

You can also create your own style sheets by copying an existing one and saving it to one of the three 

style sheet subdirectories.  New style sheets created by you are dynamically added to the step-by-

step user-interface the next time you start a publish process.

Adding a logo file to the "Logos" directory is just a simple.  Logo files must be in GIF format and 

have a GIF filename extension.  For best results pay attention to the transparency settings of your 

logo file to prevent mismatched backgrounds.  Logo files can have any dimensions.  The standard 

templates will automatically shrink or expand your logo in some cases.  If you are creating your own 

template files, there are no artificial restrictions placed on the size of your logo.

 

Input 3:  Templates 

The last of the three inputs to the parser are the two template files:  one each from the "Detailed Pages" directory and the "Summary Tables" directory.  These 

templates contain embedded keyword tags that are replaced with data from the database.  For example, for the sample diagram shown above, the tag <cb:

BotanicalName> would be replaced with "Wisteria floribunda 'Texas Purple'" for the first document, then "Cornus kousa var. chinensis" for the second 

document, and so on.  In addition to replacement tags for data fields, there are special processing tags like <cb:Prev> and <cb:Next> which are replaced 

with hyperlinks to the previous and next documents in the publication list.  For details about these replacement tags see Publication template replacement 



tags.

All other aspects of a template file may be freely modified.  For example, to insert header and footer information that you want to appear on each page, simply 

edit the template file using your favorite HTML editor. 

 



Compleat Botanica - Publication style sheets
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Each published document references three style sheets:  cbs-colorscheme.css, cbs-fontface.css, and cbs-pointsize.

css.  These files are copied to the publication directory by the publish parser from the user-selected style sheets.  You can change any 

of the predefined style sheets or create your own.  Here's what three typical style sheets look like 

  

.cbs-pagetitle { color: #204020 } 

.cbs-textlabel { color: #808080 } 

.cbs-textvalue { color: #204020 } 

.cbs-pagefooter { color: #808080 } 

.cbs-table { } 

.cbs-tableheader { background-color: #F0F0F0; color: #204020 } 

.cbs-tablevalue { background-color: #FFFFE0; color: #204020 } 

.cbs-break { color: #FFFFE0} 

"Lemon chiffon.css" defines a color scheme 

  

.cbs-pagetitle { font-family: Comic Sans MS; text-align: Center } 

.cbs-textlabel { font-family: Verdana } 

.cbs-textvalue { font-family: Georgia } 

.cbs-pagefooter { font-family: Verdana } 

.cbs-table { } 

.cbs-tableheader { font-family: Verdana } 

.cbs-tablevalue { font-family: Georgia } 

.cbs-break { } 

"Web classic.css" defines a font style 

  



.cbs-pagetitle { font-size: 18pt; } 

.cbs-textlabel { font-size: 12pt; } 

.cbs-textvalue { font-size: 12pt; } 

.cbs-pagefooter { font-size: 12pt } 

.cbs-table { } 

.cbs-tableheader { font-size: 12pt } 

.cbs-tablevalue { font-size: 12pt; } 

.cbs-break { } 

"12 points.css" defines font point sizes 

Each of the three style sheet defines different aspects of the same eight styles.  These eight styles are used as follows: 

style description

cbs-pagetitle Used for the document title.

cbs-textlabel Used for labels that describe a data field when not inside a table.

cbs-textvalue Used for data fields when not inside a table.

cbs-pagefooter Used for text at the bottom of a document.

cbs-table Used to define overall attributes of a table

cbs-tableheader Used for the first row of a multi-row table or the first column of a multi-column table.

cbs-tablevalue Used for data fields when they are part of a table

cbs-break Used to define the color of line breaks.
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Replacement tags

Replacement tags inside publishing templates take the form <cb:TagName>.  As the publication parser encounters a 

replacement tag, it looks up the current value for the tag and inserts it into the output file.  For example, if the current 

specimen record being processed is number "S101" and the genus and species are "Alchemilla", and "mollis" the parser 

would make these substitutions: 

  

<html> 

  <body> 

    Specimen Number <cb:SpecimenNumber> 

    Specimen Name <cb:Genus> <cb:

Species> 

  </body> 

</html> 

<html> 

  <body> 

    Specimen Number S101 

    Specimen Name Alchemilla mollis 

  </body> 

</html> 

Template with replacement tags Output file

  

Attributes

Replacement tags can accept attributes.  Attributes are paired values that take the form <cb:TagName 

attribute="value">.  Each replacement tag recognizes certain attributes, and ignores all others.  For example, 

many tags understand the attributes "text" and "graphics", both of which can take the values "on" or "off".  Thus the 

replacement tag <cb:Propagule> might take several forms in the template as shown in the table below (where the 

current specimen's value for propagule is "Gemmate").

Template file Output file Browser

<cb:Propagule text="on" 

graphics="on"> 

<img src="./images/6313.

jpg"> Gemmate 
 Gemmate



<cb:Propagule text="on" 

graphics="off"> 
Gemmate Gemmate

<cb:Propagule text="off" 

graphics="on"> 
<img src="./images/6313.jpg"> 

<cb:Propagule text="off" 

graphics="off"> 

Table of replacement tags

By default, each replacement tag assumes that certain attributes are "on" even when they are not explicitly specified.  

For a listing of these defaults see the Alphabetical index to column specifications.

Table of attributes

The meaning of on and off for each attribute is explained in this table.

Attribute on off

text Display the data field in text form. Do not display the data field in text form.

graphics

For RHS colors and fields which use colors to 

represent codes, such as the climate fields, 

display a rectangular color patch. 

For fields which have an iconic representation, 

display the icon.

For fields which are represented by a checkbox, 

display a checked or unchecked graphic of a 

checkbox.

For the Picture field, display the picture.

Do not display any embedded graphics for this 

field. 

 

For checkboxes, display the value as "yes" or 

"no".

For the picture field, display the picture 

filename.

code
For fields which use colors to represent codes, 

display the color patch with the code on top.
Do not display the code on the color patch.

plaintext
For the BotanicalName field only, display the 

field without italics.

For the BotanicalName field only, display the 

field in proper botanical name format.

file:///V|/ActiveProjects/CrescentBloom/www/PoxyPDF/I/F/C/default.htm


richtext

For the notes fields, display the text using the 

fonts and colors as they were applied by the 

user in the notes editors.

For the notes fields, display the text string 

using the fonts and colors as specified in the 

publication template and style sheets.

thumbnail

For the picture field, make a copy of the picture 

file compressing its filesize to match the display 

size of the picture.  This option is best for Web 

pages.

For the picture field, make a full sized copy of 

the picture file retaining its original 

composition quality.  This option will increase 

Web page display times.

The picture field can also accept optional width and height attributes.  If one of the width or height attributes is present 

the picture will be scaled to the specified width or height.  If both are present, the picture will loose its aspect ratio.  If 

neither are specified and the thumbnail attribute is on, the picture is displayed with a height of 60.

Additional replacement tags

In addition to the replacement tags which directly correspond to database fields, there are replacement tags which allow 

the template designer to embed hyperlinks and special values as well as replacement tags which are used to control 

repetition and accumulation.

Hyperlink 

replacement tag
Description

<cb:PrevPage>
This tag is replaced with a hyperlink to the previous 

document in the publication.

<cb:NextPage>
This tag is replaced with a hyperlink to the next 

document in the publication.

<cb:IndexPage>
This tag is replaced with a hyperlink from the current 

detail page to the summary table of all specimen.

<cb:DetailPage>

This tag is replaced with a hyperlink from the 

summary table of all specimen to a particular detail 

page.

Each of these hyperlink replacement tags can accept the linktext attribute.  This attribute is used to define what 

text to display for the hyperlink.  For example to display the botanical name in the hyperlink from a summary table 

to a detail page you would code the tag as: <cb:DetailPage linktext="cb:BotanicalName">

 



Special value 

replacement tag
Description

<cb:CurrentFilter> Replaced with the name of the current filter used for the publication.

<cb:PageNumber>
Replaced with the current page number for detail page templates, and the current item in 

the specimen list for summary table templates.

<cb:PageCount> Replaced with the total number of specimen records published.

 

Repetition 

replacement tag
Description

<cb:Specimen> 

</cb:Specimen>

Everything between the opening and closing tags is repeated for each specimen in the 

publication.

<cb:Column> 

</cb:Column>

Everything between the opening and closing tags is repeated for each data field in the 

current filter. 

This replacement pair is usually placed within a <cb:Specimen></cb:Specimen> pair.

<cb:HeaderValue>

Replaced with the name of the current column. 

For example, to create a list of all data field names in the current filter, the template would 

look like this:

<cb:Column> 
  <cb:HeaderValue> 
  <p> 
</cb:Column> 

This replacement tag only has meaning when placed within a <cb:Column></cb:Column> 

pair.



<cb:ColumnValue>

Replaced with the value of the current column. 

For example, to create a table of all data field values in the current filter, the template 

would look like this:

<table> 
  <tr> 
    <td> 
      <cb:Column> 
        <cb:ColumnValue> 
      </cb:Column> 
    </td> 
  </tr> 
</table> 

This replacement tag only has meaning when placed within a <cb:Column></cb:Column> 

pair.

 

Accumulation 

replacement tag
Description

<cb:Repeat> 

</cb:Repeat>

The text between these two tags is inserted when the requested number of specimen has 

been reached.  Use the every attribute to request how often to trigger this insertion. 

For example, to insert a paragraph break after every fourth specimen the template would 

look like:

<cb:Specimen> 
  . . . 
  . . . 
  <cb:Repeat every="4"><p></cb:Repeat> 
</cb:Specimen>

This replacement pair only has meaning when placed within a <cb:Specimen></cb:

Specimen> pair.



<cb:Store>

</cb:Store>

Everything between the opening and closing tags is accumulated, but not copied to the 

output file, until the next <cb:Release> tag is encountered. 

<cb:Release>

Everything accumulated by the <cb:Store></cb:Store> pair is copied to the output file. 

For example, to copy the botanical names to the output file in groups of 5, with a line break 

every 5th specimen, the template would look like:

<cb:Specimen> 
 
  <cb:Store> 
    <cb:BotanicalName> 
  </cb:Store> 
 
  <cb:Repeat every="5"> 
    <cb:Release> 
    <hr> 
  </cb:Repeat> 
 
</cb:Specimen>
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Index to "finding" topics

   Finding specimen 

records 

To begin the search for specimen records be sure that your current view is 

one of the five specimen views.  In addition, the Find command only works 

when the "current focus" is the List View. 

   Finding taxonomic 

entries 

To begin the search for taxonomic entries be sure that your current view is 

the Checklist View. In addition, the Find command only works when the 

"current focus" is the List View. 

 



Compleat Botanica - Finding specimen records

 Using the software    Finding   

The Find command takes two forms:  one for finding specimen records and one for finding taxonomic entries.  See the 

document Finding taxonomic entries for more about that.

To begin the search for specimen records be sure that your current 

view is one of the five specimen views.  In addition, the Find 

command only works when the "current focus" is the List View.  See 

What is the significance of the fancy borders? for more about this.

Here are some details about the Find window:

Item Description

file:///V|/ActiveProjects/CrescentBloom/www/PoxyPDF/I/N/B/250.htm


Find what Type a word or the first few letters of a word that you are searching for.

Exact full word match
When this is checked, partial word matches are not considered.  For example, searching 

for "palm" will not return entries for "palmatum".

Case sensitive
When this is checked, only words with the same capitalization are considered.  For 

example, searching for "Purp", will return entries for "Purple", but not for "purpurea".

Find next
Searches forward through the current set of filtered specimen to find the next match.  

Automatically scrolls the specimen list to the record matching the request. 

Find prev
Searches backward through the current set of filtered specimen to find the previous 

match.  Automatically scrolls the specimen list to the record matching the request.

 
The bottom portion of this window shows the item (the index position from the top of 

the list) matching your search request and the name of the column where it was found.

Note:  The Find command searches through the records and columns of the currently 
defined filter.  To search your entire collection, be sure to set the current filter to something 
like "Complete checklist" so that all records, and all columns are searched.

 



Compleat Botanica - Finding taxonomic entries
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The Find command takes two forms:  one for finding specimen records and one for finding taxonomic entries.  See the 

document Finding specimen records for more about that.

To begin the search for taxonomic entries be sure that your current 

view is the Checklist View.  In addition, the Find command only 

works when the "current focus" is the List View.  See What is the 

significance of the fancy borders? for more about this.

 

 

Here are some details about the Find window:
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Item Description

Find what Type a taxonomic entry or the first few letters of an entry that you are searching for.

Exact full word match
When this is checked, partial matches are not considered.  For example, searching for 

"Acer" will not return entries for "Aceraceae".

Find next
Searches forward through the Checklist to find the next match.  Automatically opens the 

taxonomic tree to the entry matching the request. 

Find prev
Searches backward through the Checklist to find the previous match.  Automatically 

opens the taxonomic tree to the entry matching the request. 

 The bottom portion of this window shows the name(s) found and their rank.
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